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5.	 Choose Edit > Purge > Clipboard to remove anything that is kept in the Clipboard’s RAM.

6.	 Reboot the computer. RAM fragments just like disks, and restarting the computer defragments the RAM.

7.	 Install more RAM.

Your Scratch Disk is Full really means that your hard disk, or combination of scratch disks, does not have 
enough room for additional, virtual RAM. It is important not to use up most of your hard disk space for storing 
your files. Back up to removable media on a regular basis and then delete files to free up space.

To avoid getting in to this mess again, back up and clean out your hard drive, or add an additional fast hard 
drive to your system.

Customizing Photoshop Preferences

PREFERENCES are application settings that allow you to customize the appearance 
of your Photoshop application, and change the way some features work. They can 
be set under the Photoshop menu in Mac OS X or in the Edit menu in Windows, 
organized by category. 

Each preference setting has a tool tip to briefly explain its function. Each time you change 
a tool, a panel, or a command setting, Photoshop saves the new configurations in its 
Preferences file on the computer’s hard disk. All but the Plug-ins and Scratch Disk 
settings and a few General settings such as Export Clipboard can be changed without 
closing and reopening Photoshop.

Photoshop Preferences are organized into the topical categories shown in the 
Preferences submenu.  

These preferences are important for the topics covered in this book:

Interpolation

INTERPOLATION, found in the General settings group, describes the method used when scaling, resizing, 
rotating, or otherwise transforming images and selections. It is the method Photoshop uses to mathematically 
determine how to fill in the “missing” pixels when upsampling, or precisely how to remove the excess pixels 
when downsampling an image. Since interpolation can degrade image quality, it is important to pick the 
method that will do the best job. 

Of the six choices of interpolation, these four will give you the best results:

■■ Bicubic, the default, gives reasonably precise resampling, resulting in 
fairly smooth tonal gradations.

■■ Bicubic Smoother is designed for minimizing artifacts when UPSAMPLING (enlarging) images.

■■ Bicubic Sharper is used to minimize softening of images when DOWNSAMPLING. This is the interpolation 
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method used for almost all the screen images in these notes. Occasionally Bicubic Sharper will over-
sharpen image areas. If that happens, undo and use plain Bicubic instead.

■■ Bicubic Automatic will automatically choose between Bicubic Smoother or Bicubic Sharper, depending 
on whether you are upsampling or downsampling. Bicubic Automatic was added in Photoshop CS6, and 
Adobe has not included it everywhere. Notably, Bicubic Automatic is not an option in the Save for Web 
dialog box.

File Handling Preferences

File Handling Preferences tell Photoshop how to save all or 
specific kinds of files. These preferences are divided into two 
parts: File Saving Options and File Compatibility (Options).

File Saving Options let you include Image Preview data 
such as icons or Windows thumbnails when you save your documents. It makes the files a little larger, but they 
are also faster to preview when opening an image. We typically use the default settings.

Images are automatically saved (by default) in the background every 10 minutes. This can be very helpful if 
Photoshop crashes while you are editing a large file (and forgot to save often). 

Next are File Compatibility options. The important preference to change here is the bottom one, Maximize 
PSD and PSB File Compatibility from Ask to Always. The native Photoshop format, PSD, was limited to 
30,000 by 30,000 pixels per image. Large document format, PSB, 
supports documents up to 300,000 pixels in any dimension, and up 
to 6 GB in size. Originally designed for huge, high resolution printed 
documents, like billboards, the PSB format is also used to edit layers 
that contain Smart Object layers. You will use PSB documents later 
in the course. Maximize PSD and PSB File Compatibility lets you 
save .psd files that can be opened in earlier versions of Photoshop as well as in .psb format.

Performance Preferences

Performance Preferences can both 
diagnose system hardware or setup 
issues, and let you tweak them. You may 
need to exit and reopen Photoshop for 
changes to take effect. 

Memory Usage

Memory usage examines how much 
random access memory (RAM) is 
theoretically available to Photoshop, 
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specifies the ideal range for your system, and then gives you a slider to adjust the RAM. The computer in the 
screen shot above has 8 GB of RAM installed, but after system usage, only 6+ GB are available, and Photoshop uses 
4 GB, leaving some RAM for other programs.  That is why Adobe recommends setting no more than 70% of your 
available RAM to Photoshop.

History States

By default, Photoshop saves 50 automatic History States in the History panel as you work on a document. If the 
RAM in your system is marginal, and you work on documents bigger than, say 5MB, you may want to lower the 
number to 10 History States and see if performance improves.

Scratch Disks Preferences

If Photoshop runs out of RAM while 
processing a command, it can use 
free, contiguous hard disk space for 
additional processing. This space is 
called a SCRATCH DISK.

If your computer system has more than 
one hard disk attached to it, additional 
drives can become extra scratch disks. This system has one hard drive, so only the internal drive (MacintoshHD) 
is assigned as a scratch disk (checked). 

The Scratch Disk region can be used to diagnose another system problem. Photoshop requires 1-2 GB of free 
disk space to install the software, but you realistically need at least 15-20 GB of free contiguous space, and more 
if you edit files with lots of layers, like you will do for this course.

If you find Photoshop crashes a lot, you may need to clean off your hard disk, or add an additional one. Adobe 
recommends that if your computer has more than one hard disk, you set your primary scratch disk to a drive other 
than the one that contains the Photoshop application. (We have not done that here.)

Units and Rulers

We will examine Units and Rulers preferences in the vector tutorial along with rulers, grids, and guides.

Type Options

We like the Type options as shipped, but you may want to enable Asian Text Options if you work in Asian 
languages.

On Your Own

The tut01 folder contains three related images that we developed for the exercises you will use in Tutorial 3. 
01-orig-circle.jpg is the original file taken with a digital camera. In 01-circle-solid.jpg, the image was cropped 
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into a square and the area outside the glass circle was 
covered with a deep red color fill layer. In 01-circle.jpg the 
opacity of the color fill layer was reduced from 100% to 
88% to let some of the foliage outside the circle show 
through. Experiment with Save for Web settings to make 
a Web-optimized version of each. Notice how the square 
vs. rectangular file dimensions affects your optimization 
settings. Also notice that with the entire image filled with 
detail, not solid color, the file sizes are quite a bit larger than the one with the solid background. That’s the 
nature of JPEG compression. 

Resources

http://www.practical-photoshop.com/pages/CC2014-pp2-resources.html#01
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available RAM to Photoshop.
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RAM in your system is marginal, and you work on documents bigger than, say 5MB, you may want to lower the 
number to 10 History States and see if performance improves.

Scratch Disks Preferences

If Photoshop runs out of RAM while 
processing a command, it can use 
free, contiguous hard disk space for 
additional processing. This space is 
called a SCRATCH DISK.

If your computer system has more than 
one hard disk attached to it, additional 
drives can become extra scratch disks. This system has one hard drive, so only the internal drive (MacintoshHD) 
is assigned as a scratch disk (checked). 

The Scratch Disk region can be used to diagnose another system problem. Photoshop requires 1-2 GB of free 
disk space to install the software, but you realistically need at least 15-20 GB of free contiguous space, and more 
if you edit files with lots of layers, like you will do for this course.

If you find Photoshop crashes a lot, you may need to clean off your hard disk, or add an additional one. Adobe 
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Practical Photoshop CC 2014, Level 2
Tutorial 2: Libraries & Camera Raw

Overview

Knowing what to include in the first tutorial of an intermediate Photoshop book is a tough challenge. Photoshop 
is such a huge application that it is very easy to forget basic skills. But this being Photoshop, we know you want to 
do fun things right away. So, what we have decided to do here is to intersperse review with two new topics:

■■ How to use LIBRARIES to store commonly-used elements

■■ The RAW file format and the Camera Raw plug in

Objectives

Libraries

■■ Identify the image elements that can be stored in the Libraries panel.

•	 Colors

•	 Layer Styles

•	 Text Styles

•	 Text snippets

•	 Graphics

■■ Create, rename, and delete libraries.

Camera Raw

■■ Evaluate the pros and cons of the Raw format and DNG.

■■ Identify the major sections of the Camera Raw dialog box.

■■ Improve image tonality and color with the Basic tab settings:

•	 Observe how the Histogram, especially with Highlights and Shadows Clipping turned on, can help 
diagnose problems with image tonality as you adjust an image. 

•	 Experiment with the White Balance settings in the Basic tab, including the Temperature and Tint 
sliders.

•	 Selectively lighten and/or darken parts of images with the Exposure, Highlghts, Shadows, Whites, 
and Blacks sliders.
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•	 Adjust image tonality with the Contrast slider.

•	 Differentiate among the Clarity, Vibrance, and Saturation sliders, and observe the effects of each 
slider.

■■ Identify and use these tools in the Camera Raw Tools panel:

•	 Zoom and Hand Tools

•	 White Balance Tool

•	 Crop and Straighten Tools

•	 Adjustment Brush Tool

■■ Explore the various ways to finish your adjustment: Save Image, Open Image, Cancel, or Done.

Libraries

The Libraries panel allows you to store frequently-used image elements for easy retrieval. Moreover, you can 
create as many different libraries as you want, so you can easily keep track of the elements unique to specific 
projects, clients, or type of work. In addition, you can sync these libraries with the Creative Cloud app so that 
you can log in to the cloud and access the libraries from anywhere. 

Guided Exercise 2.1: Work with Libraries

We are now going to create a new library and place a content into it.

1.	 Open the Photoshop application.

2.	 Set up your workspace so it is consistent with ours: 

We recommend you follow this procedure at the beginning of each new Guided Exercise sequence as you work 
through the tutorials. We will not repeat these instructions.

a.	 Choose the Essentials workspace from the Workspace Switcher menu in the 
upper right corner of the Options bar (if Essentials is not already chosen).

b.	 Then choose Reset Essentials from the Workspace Switcher menu.

c.	 To reset colors, locate the Color Controls towards the bottom of the Tools 
panel and click the black and white boxes to reset your foreground and 
background colors to the default black and white.

d.	 While you are here, review the other components of the Color Controls. 
The upper left color swatch is the foreground color and the lower color 
swatch is the background color. The double arrow swaps the foreground 
and background colors.
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e.	 Reset your tools:

1)	 Activate the Zoom Tool. (You can do this with any tool, but the Zoom Tool is a good choice 
because zooming does not change document contents.)

2)	 In the upper left corner of the Options bar, right-click the icon of the active 
tool and choose Reset All Tools from the context menu that appears.

3.	 Locate and activate the Libraries panel. 

By default, the Libraries panel should be visible after resetting the Essentials 
workspace. It will be grouped with the Adjustments and Styles panels. If the 
Libraries panel is not already visible, choose Window > Libraries to display 
the panel. If you’ve not used Libraries before, you should see the No Libraries 
Present message.

4.	 Click the “+Create New Library” button and enter 
a name for the new library, then click the Create 
button.

5.	 Create a new document. Use the default Photoshop size preset.

6.	 Add color swatches to your library:

a.	 Choose a foreground color of your liking.

b.	 Click on the Add foreground color button at the bottom of the 
Libraries panel. This adds your chosen color to the library and 
shows its color value (in hexadecimal notation). 

c.	 Add two more colors to the library. Notice that the new colors are added to 
the top of the list of colors. You can not rearrange the colors - the newest is 
always at the top.

d.	 If you add a color you don’t want, highlight it in the Libraries panel and click on the 
Trash icon at the bottom-right of the Libraries panel. You may also drag the swatch 
to the Trash icon. Please note that either way, you will not be warned that you are 
deleting a saved swatch, and the action is not Undoable.

7.	 Add a layer style to your library:

a.	 Create a new layer. Use the Pencil tool to paint a large blob in the 
center of the layer.

b.	 Use the fx button at the bottom of the Layers panel to add two or 
more effects to the layer. Here, we added Bevel & Emboss and a Drop 
Shadow to an orange blob.
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c.	 Click the fx button at the bottom of the Libraries panel. This adds the effects applied 
to the current layer to the panel in the Layer Styles section. It is automatically given 
the same name as the active layer. 

d.	 Change the name of the style by double-clicking on it, like you would change the 
name of a layer.

e.	 Replace the layer effects on the current layer with two others, then save the new 
style in the Libraries panel. Here we added a gradient overlay. Notice that the 
thumbnail in the Libraries panel shows a miniature version of the effects that 
make up the style.

8.	 Let’s say that this particular colorful blob is something that you might want to use 
again. Time to add it to your library:

a.	 Click on the Add Graphic button on the bottom of the Libraries panel. You’ll see that there’s now 
a new section in the panel for Graphics. In addition, see the small Ps 
logo to the right of the name? This shows you that this graphic was 
created in Photoshop. This matters because you can also add items 
created in Illustrator to your library.

b.	 Double-click on the Ps logo. This opens the graphic in its own document window, where you can make 
any desired changes to it. Once you save it, the library will be updated with the edits you made.

9.	 Type can be added to the Libraries panel in two different sections:

a.	 Create a type layer. Here we placed the word “Blob” right on top of the shape we 
created earlier.

b.	 You can now choose what part of the type you want to add to the Libraries panel 
— the formatting of the type layer, or the type layer itself. If you click on the 
Add Text Style button on the Libraries panel, the formatting applied to the 
type layer (font, size, and color) will be saved as a Text Style. If you click on 
the Add Graphic button, the whole type layer (with formatting intact) will 
be saved as a graphic object. Here you can see where we added it to the 
Libraries panel in both sections. Do the same thing with your type layer.

10.	 Apply your saved library items to a new document:

a.	 Create a new document, or open an existing image.

b.	 Drag the blob graphic from your library into the document window. Notice that Photoshop 
automatically creates a new layer to contain the blob shape.

c.	 Drag the type graphic into your document. You’ll see it creates a type layer for you. 

d.	 Click on one of the color swatches in the Libraries panel. The text will take on that color.
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e.	 Click on one of the Layer Styles to apply it to the type layer.

11.	 If you are logged into your Creative Cloud account, every item you add to the 
Libraries panel is automatically synchronized to the Cloud. To see a Web page 
that lists all of your library items, choose the View on Website command from 
the Libraries panel pop-up menu. This will take you to the page where you can 
see, rename, or delete your library items. You can also collaborate with others by 
inviting them to have access to your library.

The Raw Format

Professional and many consumer-level digital cameras allow you to save your images in RAW or unprocessed 
format, to provide considerable control over how each image is processed, or to process the same image in 
multiple ways for varying effects. Here is an excellent description from Adobe Evangelists Julianne Kost & Daniel 
Brown. It was written quite a while ago, but the content is still current.  
http://www.jkost.com/pdf/photoshop/cs2/AdobeCameraRaw.pdf

Advantages of the Raw Format

■■ Far greater control of image processing than other formats such as TIFF or JPEG.

■■ Raw files are typically smaller than uncompressed TIFFs.

■■ Raw files avoid the artifacts found in compressed JPEGs.

■■ Camera settings such as White Balance can be adjusted after the image is taken.

■■ Creation of high bit images, for greater detail and for more subtle editing and color correction.

■■ Restoration of overexposed areas of an image using Adobe’s Camera Raw.

Disadvantages of the Raw Format

■■ Raw images must be processed before they can be viewed or edited, adding an extra step to using these 
images.

■■ Many cameras require that Raw images be shot at the camera’s maximum resolution, making larger files 
than may be needed. And without JPEG compression, these files are really large. From a typical 8 megapixel 
camera, a Raw file takes 8 MB of storage, and a maximum-quality JPEG only 3 MB.

■■ Not only do the large Raw files gobble card space, but they also take longer to write to the camera card 
which can cause a slight delay from one shot to another (on a slower camera).

■■ The Raw format is not standardized. Each camera maker has defined its own proprietary Raw format, and 
sometimes there are even different formats between cameras made by the same manufacturer. 

http://www.jkost.com/pdf/photoshop/cs2/AdobeCameraRaw.pdf
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Adobe’s Digital Negative Specification (DNG)
Without a standardized Raw format, you can have trouble converting images if you change cameras.

If you cannot open your camera’s Raw files into Photoshop, Adobe’s Digital Negative Converter or DNG will 
let you convert those files to the DNG format, an open format for anyone to use. 

You can read more about Camera Raw and download the converter for free from Adobe at: http://www.adobe.
com/products/photoshop/extend.html. Here is what Adobe lists as the key benefits of the DNG format for 
photographers:

■■ The DNG format helps promote archival confidence, since digital imaging software solutions will be able to 
open your Raw files more easily in the future.

■■ A single Raw processing solution enables a more efficient workflow when handling Raw files from multiple 
camera models and manufacturers.

■■ A publicly documented and readily available specification can be easily adopted by camera manufacturers 
and updated to accommodate future technological changes.

The Camera Raw Plug-in

The Camera Raw plug-in that ships with Photoshop can be used non-destructively to edit not only Raw but also 
JPEG and TIFF images, which greatly expands its versatility.

■■ When you open a Raw image in one of the Adobe applications, the Camera Raw Plug-in takes over, and 
displays the Camera Raw dialog box so that you can control how the image should appear when it opens 
in that application, such as in Photoshop.

■■ The image that opens is a duplicate, so that you can keep the original, or archival version, untouched. 

Adobe has been constantly updating the Camera Raw plug-in since its inception. There are major behind the 
scenes improvements in Camera Raw CC compared with earlier versions.

Open a File in Camera Raw

If you double-click the thumbnail of a Raw image in Bridge, it automatically launches the Camera Raw plug-in 
with its huge dialog box where you can manipulate the data that the camera captured along with its associated 
metadata.

You can also open JPEG and TIFF files, the other common formats that digital cameras save in, with Camera 
Raw. However, you cannot open PSD or PDF files in Camera Raw because Raw does not support layers.

JPEG and TIFF files open directly into Photoshop unless you “divert” them into Camera Raw first. You can use 
Bridge to open JPEG and TIFF files. 

■■ In Bridge, highlight any JPEG preview in the Content pane, and then choose File > Open in Camera Raw.

http://www.adobe.com/products/photoshop/extend.html
http://www.adobe.com/products/photoshop/extend.html
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If you want to open all your JPEG and/or TIFF images in Camera Raw first, you can do so by changing your 
Camera Raw preferences in Bridge. You may want to do this temporarily when you have a lot of camera JPEGs 
to import, and then change the preference back when you are done.  We are also showing the process here in 
case you don’t want to routinely open all JPEGs and or TIFFs in Camera Raw, but Photoshop insists on doing it.

1.	 Launch Bridge, if it is not already open.

2.	 Choose one of the following to open Camera Raw Preferences:

Mac: Adobe Bridge CC > Camera Raw Preferences...

Windows: Edit > Camera Raw Preferences...

3.	 Locate the JPEG and TIFF Handling preferences at the bottom of the dialog box.

4.	 Change the preference to Automatically open all supported JPEGs.

If instead you want JPEGs and/or 
TIFFs to skip the Camera Raw step, 
restore this setting to the default 
Automatically open JPEGs with 
settings. Now only JPEG or TIFF files 
that have already been processed in Camera Raw will open directly into the Camera Raw dialog box.

Camera Raw Dialog Box Landmarks

Image Preview

When Camera Raw first opens, you may see a yellow exclamation symbol in the upper right corner of the 
image preview. Because Raw files are so large, this caution symbol informs you that Camera Raw is still loading 
the preview, and to wait until it goes away so that your preview will be accurate.

The Camera Raw Tools Panel

The Camera Raw Tools panel is at the top left corner of the 
Camera Raw dialog box, above the image preview.  

The Full Screen button to the right of the tools panel will 
expand the Camera Raw dialog box to cover the entire 
screen, and give a bigger area for the image preview. The 
actual size depends on your screen resolution.

Lets look at some of the other tools, from left to right. Here 
we will only describe what they do, but you will get to use 
them shortly.
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Zoom and Hand Tools

The Zoom Tool and the Hand Tool work similarly to their Photoshop counterparts, and they use 
the same keystrokes to increase their functionality:

■■ Activate the Zoom Tool and then click on the image preview to zoom in.  Alt/Option + Click the Zoom 
Tool to zoom out. 

■■ Double click the Zoom Tool to view at 100%.

■■ Activate and drag the Hand Tool to pan the image preview within its pane.

■■ Double click the Hand Tool to Fit in View.

■■ When another tool is active, you can press the space bar and drag the preview to temporarily use the Hand 
Tool.

You can also press and drag the Zoom Tool over a particular part of an image to 
enlarge the region to fill the Image Preview pane.

Just below the left corner of the Image preview are more Zoom controls. 

The center box displays the current zoom level, 33.3% here. The minus and plus 
buttons zoom out or in set increments. Alternately, you can click in the zoom level 
box and choose your zoom level from the Zoom menu. 

The White Balance Tool

A COLOR CAST is a non-neutral tint of a particular color, usually unwanted, which affects an entire 
photographic image evenly.

WHITE BALANCE adjustments remove unrealistic color casts so that objects which appear white in nature are 
rendered white in the photo.

The White Balance Tool lets you click on a neutral area (light, gray, or dark) in your image to set it as the 
Custom white point. All the other colors in the image are then based on this value.  The White Balance Tool 
provides a precise way to eliminate the color cast in an image. 

The Crop and Straighten Tools

When you choose the Straighten Tool and drag across an area of the image that should be a straight 
horizontal or vertical line, the image will rotate to straighten when you release the mouse. Then the Crop 
Tool will become active so that you can crop off any missing regions of the image. The Crop Tool works like in 
Photoshop, but it does not actually trim off the cropped areas until the image is opened or saved.

Spot Removal and Red Eye Removal Tools

The Spot Removal Tool is kind of a blend between the Clone Stamp and Healing Brush tools 
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7.	 Click the Auto button just above the Exposure slider.  Your image gets lighter, and the white in the flag is 
less blue.

8.	 Toggle the Highlights Clipping Warning off and on, examining both the preview and its histogram in each 
state.

With the Auto adjustment, the clipped area of the hat increases. With the clipping warning turned off, it 
becomes harder to read Bergen on the hat. The shadow clipping is in insignificant shadow areas of the 
background, that you will soon crop off. No problem there. But the troll’s hat has a 
large clipped area of pretty solid light yellow. You will need to keep an eye on that area 
as you adjust the image.

9.	 Click the Default button to restore the original White Balance.

10.	 In the Adjustments pane, change the White Balance from As Shot to Auto (this is a different Auto from 
step 7): 

a.	 Use the Undo command to compare the image preview and the histogram. Use Undo again to restore 
the adjustment.

b.	 Turn the Highlights and Shadows Clipping Warnings on and off to see if you have clipping in any 
areas of your image where detail loss will be detrimental.

If this was a Raw image rather than a JPEG, there would have been more White Balance presets. See Resources 
at the end of the tutorial for more information on the additional White Balance presets.

11.	 When you are done, go back to As Shot.

12.	 Crop the image so that it focuses on the troll:             

a.	 Choose the Crop Tool.

b.	 Press the lower right corner of the Crop Tool icon to view the Crop Tool menu, and choose 1 to 1 at the 
top of the menu. Since the troll is about as wide as he is tall, a 1 to 1 ratio will work fine here.

c.	 Drag in the Preview area to make a cropping rectangle, and drag the corners of the rectangle until you 
are pleased with your results. To focus on the troll and not his distracting background, you will remove 
quite a bit of the image as you crop it.

The area you will crop off is now SHIELDED or partially obscured. The shielded 
area will be cropped off once the image is opened in Photoshop, but it is not 
removed within Camera Raw. Non destructive cropping is a plus in case you 
accidentally remove more of an image than you intended to, but it does keep the 
file sizes large.

NOTE: we are cheating a bit here. The Canon Digital Rebel that shot the picture shot it at full 12 
megapixel resolution. We downsampled the image to make a smaller file to speed its download time.














